
Power Point 2021/365 
Level 1 

Assessment: Exploring the PowerPoint environment 

1. Which of the following are ways to interact with PowerPoint? Choose all that apply. 
a. Click buAons on the ribbon. 
b. Use the Control Panel. 
c. Use the start menu. 
d. Click buAons on the ribbons. 
e. Click buAons on the Quick Access toolbar. 

2. True or False? You edit a slide in the Slide pane. 
a. True 
b. False 

3. You’ve opened a PowerPoint presentaLon and selected a slide in the Slide pane. In the home 
tab’s Paragraph group, the commands are grayed out and therefore unavailable. Why? 

a. You need to wait unLl PowerPoint warms up. 
b. Slides can be edited only in the Slide pane. 
c. Ribbons commands become available only aPer all slides are created. 
d. Ribbon commands become available when you click on a slide element to which they 

are applicable. 
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Assessment: CreaLng a presentaLon 

1. True or false? To open, create, or save a PowerPoint presentaLon, you use Backdoor view. 
a. True 
b. False 

2. What is the command sequence for creaLng a blank presentaLon in PowerPoint? 
a. Backdoor, New, Blank presentaLon 
b. File, New, Blank presentaLon 
c. Open, New, Blank presentaLon 

3. True or false? When previewing presentaLon template designs, you can use the More Images 
arrows to display each sample slide in a different template. 

a. True 
b. False 
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Assessment: CreaLng and modifying slide content 

1. When you use the New Slide command, the new slide does which of the following? 
a. It replaces the selected slide. 
b. It’s inserted immediately following the current slide. 
c. It’s inserted immediately preceding the current slide. 
d. It’s inserted as the last slide in the presentaLon. 

2. True or false? You can insert text simply by clicking anywhere on the slide and typing. 
a. True 
b. False 

3. True or false? A hyperlink slide object can link to a desLnaLon on the World Wide Web, to 
another file, or to another locaLon in the same presentaLon. 

a. True 
b. False 

4. Which of the following statements is true for any images inserted on a slide? 
a. Before you insert the image, you must specify its final desLnaLon and size. 
b. Before you insert the image, you must specify its final desLnaLon, but you can resize the 

image at any point aPer you insert it. 



c. Before you insert the image, you must first select a desLnaLon slide, but you can move 
the image and/or resize it aPerwards. 

d. Before you insert the image, you must first select a desLnaLon slide and specify the 
image’s exact size, but you can move it freely aPerwards. 
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Assessment: Working with slide masters and layouts 

1. True or false? The easiest way to modify the forma\ng of all slides in a presentaLon at once is 
by modifying the slide master. 

a. True 
b. False 

2. Which of these acLons would you perform to change the theme of a presentaLon? 
a. In Normal view, choose SmartArt on the Insert tab. 
b. In Normal view, choose Outline on the View tab to open the gallery. 
c. In Slide Master view, choose Themes on the View tab, and select a theme from the 

gallery. 
d. In Slide Master view, choose Themes on the Slide Master tab, and select a theme from 

the gallery. 
3. True or false? One of the benefits of Slide master view is that you can change all layouts from a 

single slide master. 
a. True 
b. False 
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Assessment: Forma\ng slides and text 

1. Where can you change text styles so that all slides in a presentaLon will have idenLcally 
formaAed text. 

a. On the Slide Title layout, in the Slide Master view. 
b. On the slide text, in Master view. 
c. On the slide master. 
d. On the Text Master, in the Slide Master view. 

2. True or false? You can change the text style of a slide by unchecking Slide Master Layout opLon 
in the Slide Master view. 

a. True 
b. False 

3. How can you create a numbered list that doesn’t begin with number 1? 
a. Select the appropriate numbered list style in the Numbering gallery. 
b. Specify the starLng number of the list on the Numbering tab of the Bullets and 

Numbering window. 
c. In the Bullets and Numbering pane, uncheck the Start at 1 opLon. 
d. In the Number window, select the Customize opLon. 

4. True or false? If you’ve made all your changes to a slide background, including hiding the 
background graphics, you can restore the graphics by clicking reset Background. 

a. True 
b. False 
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Assessment: CreaLng and forma\ng shapes 

1. True or false? The Shapes gallery allows you to create mulLple shape layers at once. 
a. True 
b. False 

2. Which of the following statements about creaLng curved shapes is true? 
a. To create each curve in a single curved shape, click and drag in a rounded manner and 

avoid sharp angles. 
b. It’s important to click at the desLnaLon point to complete the shape. 
c. Double-click at the desLnaLon point to complete the shape. 
d. You’re allowed up to 24 curves in a single shape. 

3. True or false? Pressing and holding the ShiP key while drawing a line allows you to create 
perfectly straight diagonals. 

a. True 
b. False 

4. Which of the following statements about shape layers is true? 
a. To bring the back-most layer to the front, you must click Bring to Front mulLple Lmes, 

especially if there are several layers or ore. 
b. In a shape group of five layers, if the third layer contains important text, and all other 

layers are opaque, the text layer could be brought to the front to render it readable. 
c. In a shape group of five layers, if the third layer contains important text, and all other 

layers are opaque, the text on the third layer could be formaAed as bold to make it show 
through the other layers. 

d. Always send the front-most layer to the back of the stack if it obscures the layer behind 
it. 
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Assessment: Working with images 

1. Which of the following statements is true when sizing an image’s aspect raLo? 
a. Dragging a corner sizing handle is one way to preserve the image’s aspect raLo. 
b. Pressing and holding CTRL before moving a sizing handle maintains an image’s aspect 

raLo. 
c. Dragging a corner sizing handle keeps the image centered in its original posiLon. 
d. Pressing and CTRL and moving any sizing handle is the only way to preserve image 

resoluLon while enlarging or reducing it. 
2. True or false? When reposiLoning an image, care must be taken not to slide the image between 

object layers. 
a. True 
b. False 

3. What happens to the image area aPer cropping is completed? 
a. It’s reduced to the newly cropped image size. 
b. Nothing happens; the original image area border retains its posiLon. 
c. The cropped image expands to fill it. 
d. Its center remains anchored to the same point on the slide. 

4. Even aPer you’ve applied a preset style from the Picture Styles gallery, you can conLnue to apply 
individual effects to images. 

a. True 
b. False 



5. You can use Screen Clipping to capture a porLon of any program window shown in the Available 
Windows gallery. 

a. True 
b. False 
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Assessment: Working with charts 

1. True or false? When charLng your data, once you’ve decided on a chart type, if you decide to 
change the type, you can only pick one from the same type. 

a. True 
b. False 

2. Which statement about chart elements is correct? 
a. The chart Ltle is usually something you add to the chart, rather than something that 

comes from the selected data. 
b. A data series is the collecLon of chart data used in a single presentaLon. 
c. A chart legend tells the story behind the data. 
d. The category axis shows the types of data you can use for a specific type of chart. 



3. True or false? When you edit the data in an embedded Excel spreadsheet in PowerPoint, the 
resulLng chart is updated automaLcally. 

a. True 
b. False 
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Assessment: Working with tables 

1. Which of these answers describes an easy way to create a table in PowerPoint? 
a. Use the Table placeholder in the Content field. 
b. Use the Table creaLon tool on the Layout tab. 
c. Use the Insert Table icon in the Content placeholder. 
d. Use the Table tool in the Object group. 

2. True or false? When forma\ng a table, it’s a good idea to do all the minor forma\ng first, then 
select a style preset to apply, then enter the data last. 

a. True 
b. False 

3. Which of these statements about imporLng Excel tables into PowerPoint is true? 
a. Once imported, any addiLonal forma\ng that you apply to a table must be done in 

Excel. 
b. Once imported, if you need to edit table data, that must be done in Excel. 
c. Once imported, the table is actually controlled by PowerPoint. 
d. Once imported, the table becomes a picture and is no longer an independent object. 
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Assessment: Applying transiLons between slides 

1. True or false? To apply transiLon effects to all slides in a presentaLon, there’s no need to select 
all the slides before doing so. 

a. True 
b. False 

2. Which statements about transiLon effects is NOT true? 
a. TransiLon effects can be previewed by clicking Preview or Play AnimaLon. 
b. The DuraLon opLon controls the length of Lme the affected slide is displayed. 
c. Available Effect OpLons are context-sensiLve. 
d. You can use sounds from your own audio files to signal slide transiLons. 

3. True or false? In the Timing group, under Advance Slide, you can wither check On Mouse Click, 
or check APer and specify a Lme, but not both. 

a. True 
b. False 
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Assessment: Using text from other sources 



1. Which of these statements is true about imporLng a document in outline form? 
a. It must be a Word file. 
b. The source document can’t be a normal text document; it must be wriAen as an outline. 
c. When imported, the source document nis displayed one document page per slide. 
d. Click Slides from Outline in the New Slide opLons to do so. 

2. True or false? When imporLng a PDF file, you can use the “Create from file” opLon in the Insert 
Object window. 

a. True 
b. False 

3. Which statement about WordArt styles is true? 
a. WordArt styles are complementary effects combined as individual presets. 
b. To view the effects of WordArt styles, you must view the embedded object in Word. 
c. You must set the Text Fill, Text Outline, and text effects opLons before applying a 

WordArt style preset. 
d. To apply WordArt forma\ng in PowerPoint, Word must also be running. 
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Assessment: Previewing and prinLng 

1. True or false? One way to preview your printouts is to use the Preview tool on the View tab. 
a. True 
b. False 

2. Which of these opLons is not contained in the print se\ng? 
a. Double-sided prinLng 
b. Faxing 
c. CollaLng 
d. Color 

3. True or false? The benefit of having the Quick Print tool in a custom group on the ribbon is that 
it’s always visible. 



a. True 
b. False 
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Level 2 
 

Assessment: InserLng and forma\ng SmartArt 

1. The only way to create SmartArt is from exisLng text, even if it’s incomplete.  True or false. 
a. True 
b. False 

2. Which of following statements is not true? 
a. You can copy SmartArt and paste in into an Excel 2013 workbook. 
b. The List category of SmartArt can be used to illustrate both hierarchies and non-

hierarchies. 
c. Process designs all illustrate an ordered sequence of steps. 
d. A good place to start when looking for an organizaLon-chart is the Hierarchy category. 

3. You must select all text before right-clicking to convert it to SmartArt.  True or false? 
a. True 
b. False 

4. Which of the following tools can be useful when adjusLng the relaLonship of shapes in an 
organizaLonal chart? 

a. Promote, Demote, and Move 
b. Arrange, Size, and Shape Effects 



c. Reverse, Add Bullet, and Reset 
d. Change Colors, Convert, and Ameliorate 
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Assessment: AddiLonal forma\ng opLons 

1. Name the tools group that’s especially useful for creaLng, renaming, saving, and deleLng slide 
masters, as well as adding layout elements to them? 

a. The Edit Masters group 
b. The Customize group 
c. The Set Up group 
d. The Master Layout group 

2. Once you’ve added a new slide master to your presentaLon, you must add all layout elements 
separately. 

a. True 
b. False 

3. Which of these methods is the easiest for using slides from another presentaLon while keeping 
their context, preserving their appearance, and creaLng a new slide master to govern them? 

a. Copy the source slide, paste only their contents to their desLnaLon, create a new slide 
master, and copy the forma\ng of the source presentaLon’s slide master to that of the 
desLnaLon presentaLon. 

b. Drag the source slides to the new presentaLon, create a secLon for the added slides, 
create a new slide master, and copy the slides forma\ng to the new master. 

c. Copy the source slides and paste them using the Keep Source Forma\ng opLon. 



d. Create a new slide master, copy the source slides, and paste them to the new slide 
master, making sure to retain all forma\ng. 

4. If you need to restore a deleted placeholder, you can do so in the Slide Master view, using  the 
opLons in the Layout Placeholder window. 

a. True 
b. False 
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Assessment: AnimaLng slide content 

1. You can use the AnimaLon gallery to combine an entrance effect, an emphasis effect, an exit 
effect, and a moLon path.  True or false? 

a. True 
b. False 

2. Which of these statements about animaLng PowerPoint is correct? 
a. When selecLng text to be animated, you must be sure to select all the text. 
b. To animate text, you need only select the slide containing the text. 
c. Once you’ve stacked mulLple effects in an animaLon, their order can’t be changed. 
d. The most efficient way to fine-tune an effect, including Lming and grouping se\ngs, is in 

the Effect OpLons window. 



3. The AnimaLon Painter is a tool for copying all animaLon se\ngs from one animaLon to another.  
True or false? 

a. True 
b. False 

4. Which of these statements about the Lming of effects is true? 
a. Se\ng an animaLon to start WITH Previous causes it to start at the same Lme as the 

previous animaLon. 
b. For both animaLons and transiLons, the DuraLon se\ng effects how long the slide 

remains visible.  
c. The Advanced Slide se\ng allow you to advance either at a mouse click or aPer a set 

amount of Lme, but not both. 
d. Timing effects can be boiled down to three important factors, how they start, when they 

start, and who started them. 
5. When inserLng a Summary Zoom slide, a slide is automaLcally created using your selecLons.  

True or false? 
a. True 
b. False 
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a. When selecAng text to be animated, you must be sure to select all the text. 
b. To animate text, you need only select the slide containing the text. 
c. Once you’ve stacked mulLple effects in an animaLon, their order can’t be changed. 
d. The most efficient way to fine-tune an effect, including Lming and grouping se\ngs, is in 

the Effect OpLons window. 
3. The AnimaLon Painter is a tool for copying all animaLon se\ngs from one animaLon to another.  

True or false? 
a. True 
b. False 

4. Which of these statements about the Lming of effects is true? 
a. SeWng an animaAon to start WITH Previous causes it to start at the same Ame as the 

previous animaAon. 
b. For both animaLons and transiLons, the DuraLon se\ng effects how long the slide 

remains visible.  
c. The Advanced Slide se\ng allow you to advance either at a mouse click or aPer a set 

amount of Lme, but not both. 
d. Timing effects can be boiled down to three important factors, how they start, when they 

start, and who started them. 
5. When inserLng a Summary Zoom slide, a slide is automaLcally created using your selecLons.  

True or false? 



a. True 
b. False 

Assessment: InserLng and forma\ng media 

1. Which of the following statements about using sound effects in a presentaLon is NOT true? 
a. You can download audio files from an online source for use as sound effects. 
b. You can use .mp3 files for sound effects. 
c. Audio files can be used as sound effects, transiLon effects, and animaLon effects. 
d. Three allowable file formats for audio objects are .mp3, .wav., and .aif. 

2. The tools you use to work with the audio itself are located on the Audio Tool Format tab. True or 
false? 

a. True 
b. False 

3. Which of the following are important factors to consider when adding audio and video to your 
presentaLon? 

a. File format, file size, and quality. 
b. File format, file size, and noise suppression. 
c. Whether the audio and video add to or detract from the presentaLon and its purpose, 

and whether the files are of high definiLon. 
d. File size, file format, and whether the audio and video add to or detract from the 

presentaLon and its purpose. 
4. Adding audio and video objects to a PowerPoint presentaLon increases the size of the file only 

slightly.  True or false? 
a. True 
b. False 
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presentaLon? 
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4. Adding audio and video objects to a PowerPoint presentaLon increases the size of the file only 
slightly.  True or false? 

a. True 
b. False 

 

Assessment: Reviewing content and tracking changes 

1. The category of PowerPoint opLons that govern spelling, grammar, capitalizaLon, and son is 
called AutoCorrect. True or false? 

a. True 
b. False 

2. What’s the spell-checking opLon that tells PowerPoint to remember terms for future us in other 
presentaLons? Choose the best response. 

a. Ignore All 
b. Remember Term 
c. Add to DicLonary 
d. New Word 

3. When adding a new comment, you need to select a desLnaLon slide, then select the object or 
word(s) you’re commenLng on, then click New Comment.  True or false? 

a. True 
b. False 

4. When you use the Compare tool to merge two presentaLons, and then finish reviewing all 
reviewer’s changes, which response best describes the state of the presentaLon(s)? 

a. All changes are merged, except for those rejected, and the merged presentaLon is 
automaLcally saved. 

b. All changes are merged, except for those rejected, and the original presentaLon is saved 
with the new changes. 

c. All changes are merged, except for those rejected and any style effects that can’t be 
merged, and the reviewed presentaLon is automaLcally updated to reflect the new 
changes. 

d. All changes are merged, except for those rejected and any style effects that can’t be 
merged. The two compared presentaLons remain intact and unchanged, and the new, 
reviewed version awaits saving. 

Assessment answers: Reviewing content and tracking changes 

1. The category of PowerPoint opLons that govern spelling, grammar, capitalizaLon, and son is 
called AutoCorrect. True or false? 
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2. What’s the spell-checking opLon that tells PowerPoint to remember terms for future us in other 
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a. Ignore All 
b. Remember Term 
c. Add to DicAonary 



d. New Word 
3. When adding a new comment, you need to select a desLnaLon slide, then select the object or 

word(s) you’re commenLng on, then click New Comment.  True or false? 
a. True 
b. False 

4. When you use the Compare tool to merge two presentaLons, and then finish reviewing all 
reviewer’s changes, which response best describes the state of the presentaLon(s)? 

a. All changes are merged, except for those rejected, and the merged presentaLon is 
automaLcally saved. 

b. All changes are merged, except for those rejected, and the original presentaLon is saved 
with the new changes. 

c. All changes are merged, except for those rejected and any style effects that can’t be 
merged, and the reviewed presentaLon is automaLcally updated to reflect the new 
changes. 

d. All changes are merged, except for those rejected and any style effects that can’t be 
merged. The two compared presentaAons remain intact and unchanged, and the new, 
reviewed version awaits saving. 

Assessment: Saving a presentaLon in other formats 

1. If you want to save a PowerPoint presentaLon in another format that preserves slide contents 
without allowing other users to edit it, which format could you use? Choose the best response. 

a. OpenDocument PresentaLon 
b. PowerPoint 97-2003 PresentaLon 
c. Template 
d. PowerPoint Picture PresentaLon 

2. When saving a presentaLon in other formats, many of the same opLons are available in both the 
Save As window and Backstage view.  True or false? 

a. True 
b. False 

3. What’s an excellent format to use for prinLng and distribuLng all presentaLon materials?  
Choose the best response. 

a. PDF/XPS document 
b. Portable network graphics 
c. Word handouts 
d. PowerPoint Show format 

Assessment answers: Saving a presentaLon in other formats 

1. If you want to save a PowerPoint presentaLon in another format that preserves slide contents 
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a. OpenDocument PresentaLon 
b. PowerPoint 97-2003 PresentaLon 
c. Template 
d. PowerPoint Picture PresentaAon 



2. When saving a presentaLon in other formats, many of the same opLons are available in both the 
Save As window and Backstage view.  True or false? 

a. True 
b. False 

3. What’s an excellent format to use for prinLng and distribuLng all presentaLon materials?  
Choose the best response. 

a. PDF/XPS document 
b. Portable network graphics 
c. Word handouts 
d. PowerPoint Show format 

Assessment: Working with notes pages 

1. You can add slide notes in Normal view, Notes page view, and Outline view. True or false? 
a. True 
b. False 

2. Which of these statements about working in Normal view is not correct? Choose the best 
response. 

a. The Notes area can be viewed or hidden. 
b. You can enlarge the Notes area to view longer notes. 
c. Double-clicking the Notes area border displays the complete notes for that slide. 
d. You can place your inserLon point in the Notes area and type, or you can paste text 

there from other sources. 
3. Unfortunately, Note Page doesn’t display any forma\ng of notes text.  True or false? 

a. True 
b. False 

4. Which command do you use to create the actual placeholder for an extra note page? Choose the 
best response. 

a. Duplicate Slide 
b. Hide Slide 
c. Show Text Forma\ng 
d. Add Nores Page 

Assessment answers: Working with notes pages 

1. You can add slide notes in Normal view, Notes page view, and Outline view. True of false? 
a. True 
b. False 

2. Which of these statements about working in Normal view is not correct? Choose the best 
response. 

a. The Notes area can be viewed or hidden. 
b. You can enlarge the Notes area to view longer notes. 
c. Double-clicking the Notes area border displays the complete notes for that slide. 
d. You can place your inserLon point in the Notes area and type, or you can paste text 

there from other sources. 
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a. True 
b. False 

4. Which command do you use to create the actual placeholder for an extra note page? Choose the 
best response. 

a. Duplicate Slide 
b. Hide Slide 
c. Show Text Forma\ng 
d. Add Nores Page 

Assessment: Configuring, rehearsing, and presenLng slide shows 

1. In Presenter view, you must use keyboard shortcuts to navigate your presentaLon, as the mouse 
pointer is rendered unavailable.  True or false? 

a. True 
b. False 

2. Which of the following statements is true?  Choose the best response. 
a. The Rehearse Timing feature is useful for ge\ng a sense of how long it takes to show 

the individual slides, but not the duraLon of the enLre presentaLon. 
b. The Rehearse Timing feature displays slides, notes, and graphics, but it doesn’t show 

transiLons or animaLon. 
c. Presenter view can be displayed on one monitor and mulLples monitors. 
d. The primary purpose of Presenter view is to display all presentaLon components to the 

audience. 
3. Once you’ve created a custom slide show, it must be shown from the Custom Show window.  

True or false? 
a. True 
b. False 
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the individual slides, but not the duraLon of the enLre presentaLon. 
b. The Rehearse Timing feature displays slides, notes, and graphics, but it doesn’t show 

transiLons or animaLon. 
c. Presenter view can be displayed on one monitor and mulAples monitors. 
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3. Once you’ve created a custom slide show, it must be shown from the Custom Show window.  
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b. False 

Assessment: ProtecLng your presentaLon 

1. Which of the following statements about making a presentaLon as final is correct? Choose the 
best response. 

a. Clicking Mark as Final opens the Info window. 
b. Mark as Final restricts editorial access to file. 
c. Once you’re marked a presentaLon as final, it can never be edited. 
d. Once marked as final, a presentaLon can only be edited aPer the correct password is 

entered. 
2. Clicking Edit Anyway turns off read-only mode, allowing full editorial access to the presentaLon. 

a. True 
b. False 

3. Which of the following statements about password-protecLng a presentaLon if true? Choose the 
best response. 

a. The Encrypt Document window is your one chance to create a password, so you’d beAer 
get it right! 

b. If you forget a password you’ve created, you can have MicrosoP send you a Reset 
Password email. 

c. Fortunately, passwords are not case-sensiLve. 
d. When a user aAempts to open a password-protected presentaLon, she must enter the 

correct password in the Password window. 
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a. Clicking Mark as Final opens the Info window. 
b. Mark as Final restricts editorial access to file. 
c. Once you’re marked a presentaLon as final, it can never be edited. 
d. Once marked as final, a presentaLon can only be edited aPer the correct password is 

entered. 
2. Clicking Edit Anyway turns off read-only mode, allowing full editorial access to the presentaLon. 
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3. Which of the following statements about password-protecLng a presentaLon if true? Choose the 
best response. 

a. The Encrypt Document window is your one chance to create a password, so you’d beAer 
get it right! 

b. If you forget a password you’ve created, you can have MicrosoP send you a Reset 
Password email. 

c. Fortunately, passwords are not case-sensiLve. 
d. When a user a+empts to open a password-protected presentaAon, she must enter the 

correct password in the Password window. 

Assessment: Sharing your presentaLon 



1. The CompaLbility Checker is used to assess the compaLbility of your presentaLon with the 
presentaLon applicaLon other than PowerPoint.  True or false? 

a. True 
b. False 

2. Which of the following statements about checking your presentaLon for accessibility is true? 
Choose the best answer. 

a. Beside consideraLon for people with disabiliLes, accessibility can help ensure that a 
presentaLon is more friendly to internaLonal users. 

b. In PowerPoint, “accessibility” refers to whether viewers of the presentaLon are allowed 
editorial access to it. 

c. If not fixed, any accessibility error will prevent the presentaLon from running. 
d. Any accessibility errors that you fix are saved automaLcally. 

3. If you have to compress the media in a presentaLon, you should always apply the least amount 
of compression.  True or false? 

a. True 
b. False 

4. Which of these statements about sharing presentaLons is not true? Choose the best response. 
a. Depending on the cloud provider being used, recipients of a shared presentaLon might 

not need to have an account with that provider. 
b. Emailing a link is highly preferable over emailing a presentaLon. 
c. Saving to a cloud provider requires subscripLon to that provider. 
d. To share a presentaLon using a cloud service, the presentaLon must first be uploaded to 

it. 
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b. Emailing a link is highly preferable over emailing a presentaLon. 
c. Saving to a cloud provider requires subscripLon to that provider. 
d. To share a presentaAon using a cloud service, the presentaAon must first be uploaded 

to it. 

 

 

 

 

 

 

 


